
Liebe Pandasoft Kundinnen und Kunden,

wir freuen uns, Ihnen mit dem neuen Katalog wieder eine neue Demo CD
übergeben zu können. Diesmal haben wir die Anzahl der Demos reduziert,
um Ihnen eine Vielzahl von Updates und Patches zur Verfügung zu stellen.

Im Ordner "Nützliches" finden Sie den Ordner "Internet Tools", der Sie mit
Mail-, Browser- und Konfigurationssoftware versorgt. Der Adobe Acrobat
Reader 3.0 (zum Lesen der Produktdatenblätter im PDF Format) liegt im
Ordner "Freie Utilities". Wenn Sie ältere Demos suchen, hilft Ihnen das
Programm TRI Katalog im Ordner "Nützliches". Dort haben wir unsere
Demo CD´s katalogisiert. Pandasoft präsentiert sich auch im Internet.
Doppelklicken sie die Datei www.pandasoft.de im Ordner "Bitte zuerst
lesen". Auf unserer Homepage finden Sie aktuelle Infos und Angebote zum
Macintosh. Schreiben Sie uns ein E-mail für Anfragen oder Bestellungen.
Die Adressen finden Sie auf unserer Homepage.

Viel Spaß mit der neuen CD wünscht Ihnen das Pandasoft Team.

Berlin, den 26.9.1997



Katalog-Addendum
Sonderangebote

Sehr geehrte Kundin, sehr geehrter Kunde.

Nachstehend finden Sie unsere aktuellen Sonderangebote.
Die Liste wird laufend erweitert und aktualisiert. Bitte informieren
Sie sich auf unsere Homepage
(http://www.pandasoft.de/html/neuheiten/reposo.html),
besuchen Sie uns in unseren Verkaufsräumen in Berlin oder rufen
Sie uns einfach an.

Bei den angebotenen Produkten handelt es sich um
Einzelexemplare, Restauflagen, ältere Versionen, o. ä.
Wir bitten daher um Ihr Verständnis, daß wir für diese Titel keine
Gewähr für die Lauffähigkeit unter bestimmten
Systemkonfigurationen übernehmen können.
Wir garantieren die Vollständigkeit der Produkte.
Rücknahme, Umtausch, Wandlung oder Minderung sind
ausgeschlossen.
Die Angebote gelten, solange der Vorrat reicht.

Mit freundlichen Grüßen
Ihr Pandasoft-Team

Dr.-Ing. Eden GmbH
Uhlandstraße 195

10623 Berlin-Charlottenburg

Versand Tel.: (030) 32 77 18-28 • Fax: -55
Laden Tel.: (030) 31 59 13-0 • Fax: -55
Internet: http://www.pandasoft.de



Artikelbezeichnung                                                                                                          Best.-Nr.           VK       
A Stroll in XXth Century Art CD-ROM en. MH623C 60,—
A-Ko Screen Saver CD-ROM en. SU551C 33,—
ABC News Interactive: Eartquake CD-ROM en. SO585C 75,—
Abuse CD-ROM en. BU528C 56,—
AddDepth 2 CD-ROM en. 2.0 RY503C 97,—
ADI Junior (4 - 5 Jahre II) CD-ROM dt. SO664C 63,—
ADI Junior (6 - 7 Jahre II) CD-ROM dt. SO668C 63,—
Advanced Dungeons & Dragons Collector’s Edition CD-ROM en. SM500C 72,—
AEC Information Manager en. AM543D 932,—
Afterlife CD-ROM dt./en. LU533C 74,—
Algorithmen in C++ CD-ROM dt. AW963C 27,—
Alice In Chains “Jar Of Flies” CD-ROM en. CP602C 28,—
Alley 19 Bowling CD-ROM en. SP606C 78,—
ALSoft Power Utilities en. 1.10 AS510D 140,—
AMBER: Journeys Beyond CD-ROM en. GS581C 85,—
Animated StoryBook: 101 Dalmatians en. DY606C 75,—
Animated StoryBook: Hunchback en. DY605C 75,—
Animated StoryBook: Winnie the Pooh en. DY603C 67,—
Apprende Español con el hijo de Asterix Disco 1 CD-ROM multilingual ET556C 99,—
Apprende Español con el hijo de Asterix Disco 2 CD-ROM multilingual ET557C 79,—
Apprenez le Francais avec le fils d'Astérix Disque 1 CD-ROM französisch ET542C 99,—
Apprenez le Francais avec le fils d'Astérix Disque 2 CD-ROM französisch ET544C 34,—
Art de la Table: Die süßen Geheimnisse der besten Patissiers CD-ROM dt. AI592C 95,—
Art de la Table: Die vier Jahreszeiten der feinen Französischen Küche CD-ROM dt. AI591C 109,—
Art de la Table: The Four Seasons of Gourmet French Cuisine CD-ROM dt. AI595C 60,—
Art de la Table: Vegetarian Delights CD-ROM dt. AI596C 69,—
Artastic Clipart Vol. 1: Food CD-ROM en. FC501C 21,—
Artworks for Computer: Anthony Casay Collection CD-ROM en. SN623C 17,—
Artworks for Computer: Anthony Casay III Collection CD-ROM en. SN624C 17,—
Artworks for Computer: Castles of Europe CD-ROM en. SN626C 17,—
Artworks for Computer: Dragon Tales CD-ROM en. SN621C 16,—
Artworks for Computer: Impressionist Masters CD-ROM en. SN625C 17,—
Artworks for Computer: Sky Raiders CD-ROM en. SN622C 17,—
AstroRock: The Epic Adventures of Zed Nepher CD-ROM en. AI643C 16,—
Atari 2600 Action Pack CD-ROM en. AC526C 48,—
Auf den Spuren von Haydn CD-ROM dt. EU541C 49,—
authentic — the techno reference CD-ROM dt. VG542C 32,—
Baba Jaga und die Zaubergänse CD-ROM dt. DA534C 45,—
Backgrounds Vol. 1 CD-ROM dt. FU523C 64,—
Backgrounds Vol. 2 CD-ROM dt. FU524C 64,—
Backgrounds Vol. 3 CD-ROM dt. FU525C 64,—
Battle Beast CD-ROM en. SL582C 69,—
Bedlam CD-ROM en. MG311C 96,—
Bella Italia Sprachtrainer CD-ROM Deutsch/Italienisch IX654C 27,—
Blind Date CD-ROM en. DO544C 52,—
Bob Dylan’s Greatest Hits Volume 3 CD-ROM en. CP601C 37,—
Bolo CD-ROM dt. 1.0.6 DW508C 45,—
Brian Thomas & Friends: If Monks had Macs CD-ROM en. VO591C 42,—
Bridge Deluxe with Omar Sharif CD-ROM en. IP505C 15,—
Calendar Creator en. 2.0 PW501D 82,—
Candy Land Adventure CD-ROM en. HO601C 39,—
CatchWord Pro en. LO545D 49,—
Ceterum Censeo Sprachtrainer CD-ROM Lateinisch/Deutsch IX655C 27,—
Charles Bukowski: Kaputt in Hollywood (Gedichte) dt. VO553D 19,—
ChemIntosh Standard dt. 3.4.4 CW542D 620,—
ChemWindows en. 3.1 CW942D 613,—
Circus CD-ROM dt. MH622C 18,—



Artikelbezeichnung                                                                                                          Best.-Nr.           VK       
ClickChange en. 2.5.2 DC530D 126,—
Close Combat CD-ROM en. MS346C 78,—
Coates Art Review Volume One: Impressionism CD-ROM en. CO541C 17,—
College Advisor CD-ROM en. PR644C 78,—
Colorize en. 2.0 GD551D 569,—
ColorMacCheese dt. BP534D 37,—
Communicate BTX dt. MK511D 80,—
Communicate Lite dt. MK512D 89,—
COPYright Pro Singleuser en. CG552D 120,—
CorelSCSI en. 2.0 CO620D 132,—
Critical Mass: America’s Race to Build the Atomic Bomb CD-ROM en. CB541C 94,—
Dance Mission Interaktiv CD-ROM TT556C 34,—
Darkseed CD-ROM dt. CY561C 48,—
Darkseed dt. CY561D 33,—
Darkseed II CD-ROM en. CY563C 90,—
Das Abenteuer Leben CD-ROM dt. UH542C 39,—
Das Jahr im Bild CD-ROM dt. 1994 CA621C 10,—
Das Oxyd Buch dt. DW501B 33,—
das digitale Bild CD-ROM dt. TY601C 87,—
Der Froschkönig CD-ROM dt. SV603C 12,—
Descent CD-ROM en. IP325C 85,—
Descent II CD-ROM en. IP326C 101,—
Descent Levels of the World CD-ROM en. IP327C 31,—
Die INtex Schatztruhe CD-ROM dt. IX664C 19,—
Die Postlightzahlen dt. IM600D 51,—
Dungeon Master 2 CD-ROM dt./en. IP524C 81,—
Easy English CD-ROM dt./en. WM601C 67,—
EasyTextures Vol. 1 CD-ROM dt. ET601C 107,—
EasyTransfer dt. 3.2 AC582D 656,—
Ecoutez bien Volume 1 CD-ROM französisch ET552C 131,—
Ecoutez bien Volume 1+2 CD-ROM französisch ET554C 144,—
Ecoutez bien Volume 2 CD-ROM französisch ET553C 101,—
Encyclomedia II CD-ROM-Collection en. M4293L 74,—
Endorfun dt. TW600C 60,—
English Grammar CD-ROM dt./en. WM602C 67,—
Envelopes Deluxe für Illustrator en. 1.0 LS511D 258,—
Envelopes Standard für Illustrator en. 1.0 LS510D 129,—
España ole! Sprachtrainer CD-ROM Deutsch/Spanisch IX656C 27,—
Euroglot Compact Business Pack CD-ROM 2.0 HE556C 259,—
Euroglot Compact Deutsch/Italienisch CD-ROM 2.0 HE554C 45,—
Euroglot Compact Deutsch/Niederländisch CD-ROM 2.0 HE555C 64,—
Euroglot Compact Deutsch/Spanisch CD-ROM 2.0 HE553C 45,—
Euroglot Professional Deutsch/Englisch CD-ROM 2.0 HE571C 370,—
Euroglot Professional Deutsch/Französisch CD-ROM 2.0 HE572C 370,—
Euroglot Professional Deutsch/Italienisch CD-ROM 2.0 HE574C 370,—
Euroglot Professional Deutsch/Niederländisch CD-ROM 2.0 HE575C 370,—
Euroglot Professional Deutsch/Spanisch CD-ROM 2.0 HE573C 370,—
Events That Changed The World CD-ROM IE501C 67,—
ExPro dt. 1.3 RV521B 53,—
Extreme Fun Pak CD-ROM en. AP515C 85,—
F/A-18 Hornet Tour of Duty: Korean Crisis CD-ROM en. 2.0 GS579C 48,—
First Person: Donald A. Norman –

Defending Human Attributes in the Age of the MachineCD-ROM en. VO572C 56,—
First Person: Mumia Abu-Jamal, Live from Death Row CD-ROM en. VO598C 41,—
First Person: Stephen Jay Gould – On Evolution CD-ROM en. VO575C 67,—
Gabriel Knight II: The Beast Within CD-ROM dt./en. SO659C 62,—
Gabriel Knight II: The Beast Within Clue-Book dt. 1. Auflage SO646B 9,—



Artikelbezeichnung                                                                                                          Best.-Nr.           VK       
Games of Fame Volume 1 CD-ROM en. CD500C 61,—
Games of Fame Volume 2 CD-ROM en. CD501C 63,—
Games of Fame Volume 3 CD-ROM en. CD516C 76,—
Garden Problem Solver CD-ROM en. SN602C 69,—
God Save the Queen Sprachtrainer CD-ROM dt./en. IX657C 27,—
Golden Gate Killer CD-ROM dt. EL562C 63,—
Haight Ashbury in the Sixties CD-ROM en. CN616C 64,—
Hardline CD-ROM en. VG516C 67,—
Hase und Igel CD-ROM dt. SV604C 12,—
HAVOC CD-ROM en. RB592C 77,—
Head Candy CD-ROM dt. IO623C 35,—
Help! en. 2.4 HE501D 160,—
Hexen CD-ROM en. GT603C 112,—
History through Art 800 B.C. - A.D. 1550 CD-ROM en. ZI502C 71,—
History through Art 1545 - 1990 A.D. CD-ROM en. ZI503C 71,—
HSC Power-Bundle dt./en. HS601P 328,—
Imo und der König CD-ROM dt. DA532C 45,—
Info-Mac X CD-ROM en. 1997 PH621C 39,—
Infoline: Sprachtrainer Englisch CD-ROM dt. IX676C 25,—
Inside the GRE CD-ROM en. PR642C 78,—
Interactive Herbie — Right Type of Mood CD-ROM en. CI601C 14,—
Interactive Physics 10er-Lizenz en. 2.5 PK501N 1111,—
Interactive Physics en. 2.5 PK501D 279,—
Interaktives Filmbuch: König der Löwen dt. 2.0/DE DY621C 74,—
Interaktives Filmbuch: Pocahontas dt. 1.0 DY622C 68,—
Interaktives Filmbuch: Toy Story dt. 1.1 DY624C 69,—
Ishido en. IP515D 54,—
It's Elementary CD-ROM en. AP316C 158,—
Jack & die Bohnenstange CD-ROM TM618C 48,—
Jump - The David Bowie Interactive CD-ROM en. IO601C 58,—
Kaleidoscope en. 2.0 AO556D 65,—
Key Discovery CD-ROM dt. KY548C 41,—
Kid Pix Companion en. BB516R 48,—
Kingdom Book One: The Far Reaches CD-ROM en. IP537C 45,—
Koyn Frac Studio & DFL en. TB529P 246,—
Koyn Frac Studio en. TB527D 171,—
KPT Bryce CD-ROM en. 2.0 HS603C 275,—
KPT Bryce dt. 1.1 HS616D 114,—
KPT Convolver dt. 1.0 HS617D 166,—
KPT Final Effects AP CD-ROM HS606C 253,—
KPT Final Effects für After Effects CD-ROM HS602C 758,—
KPT Vector Effects dt. 1.0 HS618D 194,—
Kursbuch Gesundheit CD-ROM dt. PH531C 51,—
LabVIEW Student Edition en. 3.1 NI561W 89,—
Laurie Anderson with Hsin-Chien Huang: Puppet Motel CD-ROM en. VO586C 53,—
Le français facile CD-ROM französisch/deutsch WM603C 67,—
Learn English with Asterix an the Secret Wapon Disc 1 CD-ROM en. ET545C 101,—
Learn English with Asterix an the Secret Wapon Disc 2 CD-ROM en. ET546C 101,—
Learn English with Asterix and Son Disc 1 CD-ROM en. ET541C 99,—
Learn English with Asterix and Son Disc 2 CD-ROM en. ET543C 99,—
Lecker Schmecker CD-ROM dt. IX662C 19,—
Legend of Lemnear CD-ROM japanisch/englisch SU557C 24,—
Listen! Volume 1 CD-ROM en. ET549C 101,—
Listen! Volume 1+2 CD-ROM en. ET551C 144,—
Listen! Volume 2 CD-ROM en. ET550C 101,—
Living Books: Aesops Fabel Die Schildkröte und der Hase CD-ROM en. BB598C 46,—
Living Books: Janell Cannon's Stellaluna CD-ROM en. BB639C 58,—



Artikelbezeichnung                                                                                                          Best.-Nr.           VK       
Living Books: Mercer Mayer’s Nur Oma und ich CD-ROM dt. BB627C 46,—
Lode Runner On-Line: The Mad Monks’ Revenge CD-ROM en. SO653C 75,—
Lode Runner: The Legend Returns CD-ROM en. SO629C 83,—
Lost Eden CD-ROM en. VG514C 92,—
Love Vision CD-ROM PR661C 40,—
M&T-Ratgeber Tiere: Hunde CD-ROM dt. II661C 32,—
M&T-Ratgeber Tiere: Katzen CD-ROM dt. II662C 32,—
Mac 4 Pac CD-ROM en. IP520C 51,—
Mac Arcade Pack 2 CD-ROM en. WW526C 38,—
Mac Golf Pack CD-ROM en. PD691C 54,—
Mac PowerCollection CD-ROM dt. 3.0 TW589C 23,—
Mac330 VT330 Terminalemulator en. 1.3 WS582D 344,—
MacGreek Old Testament en. LT547D 80,—
Macintosh Game Pack en. WW521D 44,—
Macintosh Programmer’s Toolbox Assistant CD-ROM en. AW835C 190,—
Malen und Spielen: König der Löwen dt. 1.1 DY631C 74,—
Marathon 2 CD-ROM en. BU525C 87,—
Marathon CD-ROM en. BU524C 53,—
Marathon en. BU524D 77,—
Marathon Infinity CD-ROM en. BU526C 54,—
Marty und das Abenteuer mit dem Käse CD-ROM dt. BB634C 60,—
Marvin der Affe ...auf der Flucht... CD-ROM TM616C 48,—
MasterCook Deluxe CD-ROM en. 4.0 SO545C 77,—
MasterCook Mac CD-ROM en. AO621C 68,—
MasterJuggler Pro en. 2.0 AS512D 90,—
Material World: A Global Family Portrait CD-ROM en. SP641C 82,—
Mit dem Mac Online CD-ROM dt. 3. Auflage IX633C 21,—
Mortimer and the Riddles of the Medallion CD-ROM en. LU331C 71,—
Mortons Musik-Malkasten CD-ROM dt. RO621C 45,—
Multimedia Guns CD-ROM en. II564C 54,—
Multimedia Toolbox CD-ROM en. WZ541C 76,—
Music Mega CD-ROM dt. SP629C 52,—
Norman Bosworth Photos Vol. 1 CD-ROM en. PH641C 34,—
On the Rocks CD-ROM dt. IX663C 19,—
Open Sesame! en. 1.1.1 CR600D 100,—
Open Sesame! OEM-Version en. 1.1.1 CR600X 18,—
Our Times CD-ROM en. 1996 VI522C 92,—
Out Of This World en. IP506D 68,—
Oxyd 1 Pack dt. DW502D 48,—
Oxyd magnum! CD-ROM dt. 3.4 DW503C 53,—
Oxyd magnum! dt. 3.4 DW503D 41,—
Oxyd-Diskette dt. 3.4 DW501D 5,—
PageTools en. 2.0 EX591D 203,—
Pandora's Poker Palace CD-ROM en. AI642C 13,—
Paper CD Volume 1: Fiber Paper CD-ROM en. PH631C 45,—
Paper CD Volume 2: Speckled Paper CD-ROM en. PH632C 45,—
Paper CD Volume 3: Cloud Paper CD-ROM en. PH633C 45,—
Paper CD Volume 4: Stardust Paper CD-ROM en. PH634C 45,—
Paper CD Volume 5: Wheat Paper CD-ROM en. PH635C 45,—
Per.Oxyd dt. DW509D 45,—
Peter & Julies Farben-Abenteuer CD-ROM dt. AR605C 56,—
Peter & Santa Claus CD-ROM dt. AR604C 56,—
Peters Magisches Abenteuer CD-ROM dt. AR607C 56,—
Peters Nummern-Abenteuer CD-ROM dt. AR606C 56,—
Phantasmagoria CD-ROM dt./en. SO651C 78,—



Artikelbezeichnung                                                                                                          Best.-Nr.           VK       
Playtoons Volume 1: Onkel Archibald CD-ROM dt. SO638C 20,—
Playtoons Volume 2: Spirou - Rummeldorf hoch zwei CD-ROM dt. SO639C 20,—
Playtoons Volume 3: Das Geheimnis des Schlosses CD-ROM dt. SO640C 20,—
Playtoons Volume 4: Der Mandarin Prinz CD-ROM dt. SO655C 35,—
Playtoons Volume 5: Der Stein von Wakan CD-ROM dt. SO656C 20,—
Playtoons Volume 6: Wilder Westen CD-ROM dt. SO665C 18,—
Playtoons Volume 7: Monster CD-ROM dt. SO666C 18,—
Playtoons Volume 8: Ritter CD-ROM dt. SO667C 18,—
Plottergeist en. 2.2 GD527D 591,—
Pok, der kleine Künstler CD-ROM dt. AR611C 56,—
Police Quest V: SWAT dt./en. SO348C 75,—
Power Play Pack CD-ROM en. DO346C 76,—
Power Translator Professional Deutsch/Englisch 4.0 HE540D 574,—
Prime Target CD-ROM en. BU329C 66,—
PYST CD-ROM en. PD681C 27,—
Quest For Fame CD-ROM en. IB520C 65,—
QuickTools AV522R 48,—
Resorcerer en. 1.2.5 MA506D 357,—
Roddy on the Road CD-ROM dt. EF622C 36,—
Route 66 — Straße der Sehnsucht CD-ROM dt. US604C 51,—
Sci-Fi & Fantasy Clipart: Atlantis to the Stars CD-ROM en. CT511C 9,—
ScreenReady en. 1.0 AD530C 279,—
Scripter en. 1.0 ME681D 445,—
Secrets of Luxor CD-ROM dt. MJ582C 23,—
Shivers CD-ROM dt./en. SO660C 64,—
Shivers CD-ROM en. SO649C 75,—
Shockwave Assault CD-ROM dt./en. EA560C 74,—
Simulink en. MW511D 1628,—
SoftwareVAULT: The Collection for the Macintosh CD-ROM en. DI601C 21,—
Solid State Pinball: Crystal Caliburn en. SP601D 45,—
Solitaire Antics CD-ROM en. MP601C 30,—
Son of Stupid Mac Tricks (mit Diskette) en. AW630B 38,—
Space Quest VI CD-ROM dt./en. SO630C 66,—
Space Quest VI Clue-Book dt. 1. Auflage SO630B 9,—
Space World CD-ROM dt. SV608C 18,—
SpellingCoach Professional en. 4.1 DS596D 101,—
Spiel mit uns im Park CD-ROM dt. RO625C 41,—
Spieleparadies: Aladdin dt. 2.0 DY630C 80,—
Stacker en. 2.0 SC581D 131,—
Star Trek - The Next Generation Screen Saver CD-ROM dt./en. 1.0 BE531C 30,—
Star Trek Borg CD-ROM en. SS667C 83,—
Star Trek Klingon CD-ROM en. SS665C 83,—
Star Trek Omnipedia CD-ROM en. SS663C 69,—
Star Trek: Deep Space Nine - Harbinger CD-ROM en. MP651C 56,—
Star Trek: Judgement Rites CD-ROM en. IP529C 79,—
Star Wars Screen Entertainment en. LU512D 37,—
Star Wars: Dark Forces CD-ROM en. LU513C 53,—
Stephen Biesty’s Incredible Cross-Sections Stowaway! CD-ROM en. DK543C 54,—
Strategic Conquest en. 4.0 DT595D 75,—
Strategy Games of the World CD-ROM en. ED529C 77,—
Stupid Mac Tricks (mit Diskette) en. AW588B 38,—
System Shock CD-ROM dt./en. OS314C 91,—
Terminal Velocity CD-ROM en. WW328C 63,—
The Crazy Wild Animals: Ewald, der Eisbär CD-ROM dt. AR608C 56,—
The Crazy Wild Animals: Kevin, das Känguruh CD-ROM dt. AR609C 56,—
The Crazy Wild Animals: Ludwig, der Löwe CD-ROM dt. AR610C 56,—
The Crystal Skull CD-ROM en. SI681C 58,—



Artikelbezeichnung                                                                                                          Best.-Nr.           VK       
The Dark Eye dt./en. TW601C 66,—
The Horde Rock Festival CD-ROM en. PH532C 47,—
The Lawnmover Man + Cyberwar CD-ROM en. TV520C 91,—
The Lawnmover Man CD-ROM en. TV522C 84,—
The Little Mac Toolkit (mit CD-ROM) en. 1st Edition PP547B 61,—
The Lord of Tantrazz CD-ROM en. AI641C 83,—
The Residents’ Gingerbread Man CD-ROM en. IO624C 60,—
The Residents: Bad Day on the Midway CD-ROM en. IA541C 79,—
The Simpsons ScreenSaver en. 1.0 BE512D 35,—
Timelapse CD-ROM en. GE572C 98,—
Timon & Pumbaa's Jungle Games en. DY640C 67,—
Toad The Wet Sprocket “Dulcinea” CD-ROM en. CP603C 37,—
Top 10 Pick for Mac CD-ROM en. PH620C 76,—
Top Ten Mac Pak CD-ROM en. EA546C 54,—
Total Distortion CD-ROM dt. PR622C 66,—
Totally Twisted Screen Saver en. 3.2 BE522D 30,—
Translate it! Deluxe CD-ROM dt. OA558C 32,—
Treasure Pack I CD-ROM en. WZ535C 22,—
Trek Academy CD-ROM dt. VG541C 32,—
Tschaikovskys 1812 CD-ROM en. FV504C 69,—
Twelve Roads to Gettysburg CD-ROM en. EB503C 75,—
Überraschungsfiguren: Der Welz-Katalog auf CD-ROM dt. AI701C 18,—
Ultimate Solar System CD-ROM en. AR682C 20,—
Under A Killing Moon CD-ROM en. AS650C 47,—
UnderWare dt. BJ502D 44,—
VideoPhone en. CN518D 91,—
Vikings CD-ROM dt. WN538C 39,—
Vive la France Sprachtrainer CD-ROM Deutsch/Französisch IX658C 25,—
Vollgas CD-ROM dt./en. LU515C 68,—
Von Kopf bis Fuß CD-ROM dt. SV521C 74,—
VroomBooks: Die vierfüßigen Freunde CD-ROM dt. TM617C 48,—
VroomBooks: Stradiwackius - Eine Symphonie zum Zählen CD-ROM dt. TM615C 48,—
Wayzata's Best of Shareware for Macintosh CD-ROM en. V. 2.0 WZ528C 19,—
WebArranger CD-ROM en. 2.0 CE571C 149,—
White Knight en. 11.14 FS301D 210,—
White Knight en. 12 FS501D 151,—
Who Built America? CD-ROM en. VO544C 67,—
Wilf CD-ROM dt. MT508C 20,—
Wine Guide CD-ROM en. 1.0 MS541C 52,—
Wing Commander III CD-ROM dt./en. OS513C 81,—
Wings: Midway to Hiroshima CD-ROM en. DC632C 64,—
Wizardry Gold CD-ROM en. SR503C 83,—
Woodstock CD-ROM en. TM582C 55,—
Word Smart CD-ROM en. PR643C 78,—
World Atlas CD-ROM en. 6.0 EA518C 61,—
WriteNow CD-ROM en. 4.0 TR501C 7,—
WriteNow en. 4.0 TR501D 87,—
Zoop dt./en. VN582D 40,—
Zork Nemesis CD-ROM en. IC314C 72,—
ZPC CD-ROM en. ZO541C 101,—
Zusatzwörterbuch Microdictionary Banking zu Power Translator HE548D 223,—
Zusatzwörterbuch Microdictionary Business/Financial zu Power Translator HE545D 111,—
Zusatzwörterbuch Microdictionary Computer zu Power Translator HE547D 111,—
Zusatzwörterbuch Microdictionary Legal/Law zu Power Translator HE546D 223,—
Zusatzwörterbuch Microdictionary Medizintechnik zu Power Translator HE558D 223,—
Zusatzwörterbuch Microdictionary Telekommunikation zu Power Translator HE557D 223,—



Produktbezeichnung                                                                                                                Best.-Nr.                 VK                  Erforderlich                                                          
4D Developer Kit auf 4D Desktop en. 6.0 AU630J 699,— ➀ ➁ ➅
4th Dimension dt. 6.0 AU630U 2.099,— ➀ ➁ ➅
4th Dimension dt. 6.0 AU630V 399,— ➀ ➁ ➅
Acrobat CD-ROM dt. 3.0 AD548U 168,— ➀ ➁
After Effects 2.0 => 3.1e Pro AD617V 168,— ➀ ➁
Apple Media Tool => dt. 2.1 dt. 2.1 M3871U 299,— ➀ ➆
AppleShare en. 5.0 M2936Z 1.138,— ➀ ➁
C++/PPC CD-ROM en. 8.5 SY301U 428,— ➄
CadMover (von Version 3.0/3.4) en. 5.0 KN501U a.A. ➀ ➁
Canvas (von allen Versionen) dt. 5.0 DS594U 399,— ➀ ➁
Captivate en. MY505U 128,— ➄
CD-ROM Toolkit en. 2.5 FW509U 69,— ➀ ➁
Chem3D auf Chem3D Pro en. 4.0 CS562U 938,— ➀ ➁
ChemDraw => Pro 4.0 CS961U 698,— ➀ ➁
ChemDraw auf ChemDraw Pro en. 4.0 CS561U 698,— ➀ ➁
ChemDraw en. 4.0 CS551U 409,— ➀ ➁
ClarisDraw dt. 1.5 CL530U 169,— ➀ ➁
ClarisImpact dt. 2.0 CL592U 169,— ➀ ➁
ClarisWorks dt. 5.0 CL527U 149,— ➀ ➁
Classic TeXtures (von Version 1.8) en. 1.8.1 BS603V 138,— ➀ ➁
Classic TeXtures (von Version <1.5) en. 1.8.1 BS603U 388,— ➀ ➁
Classic TeXtures PPC-Version (von 68K-Version) en. 1.8.1 BS303U 498,— ➀ ➁
Classic TeXtures PPC-Version (von Version 1.8) en. 1.8.1 BS303V 138,— ➀ ➁
Classic Textures 1.7 68K => 1.8 BS303K 438,— ➀ ➁
Classic Textures 1.7 => 1.8 BS603J 298,— ➀ ➁
Classic Textures 1.7 PMac => 1.8 BS303J 298,— ➀ ➁
Classic Textures 1.8 68K => 1.8                                                                                                           BS303X                    298,—              ➀        ➁                                                    
➀ Name und Anschrift des reg. Benutzers ➁ Angabe der Seriennummer ➂ Photokopie der Seriennummer
➃ Originaldiskette/CD ➄ Photokopie der Originaldiskette/CD ➅ Photokopie des Kaufbelegs ➆ Handbuchdeckel



Produktbezeichnung                                                                                                                Best.-Nr.                 VK                  Erforderlich                                          
Conflict Catcher en. 4.0 CJ514U 88,— ➄
CorelDRAW Suite 6 Upgrade CD-ROM dt. CO307J 318,—
Cubase Audio => Audio XT 3.0 dt. dt. 3.0 SE529U a.A. ➀ ➁
Cubase Score VST dt. 3.5 SE527U a.A. ➀ ➁
Cumulus Desktop 2.5 => dt. 3.0 dt. 3.0 SO698V 59,— ➀ ➁
Cumulus Network Client dt. 2.5 => 3.0 dt. 3.0 SO697V 29,— ➀ ➁
Cumulus Server dt. 2.5 => 3.0 dt. 3.0 SO697U 299,— ➀ ➁
Cyrillic II en. 7.5 LT573U a.A. ➀ ➁
Data Desk (von Version 3.x) en. 5.0 OD511U 628,— ➀ ➁
Data Desk (von Version 4.x) 5.0 OD511V 448,— ➀ ➁
Debabelizer => 1.6.5 EQ541U 279,— ➄
Deck II 2.5 DD508U 228,— ➀ ➁
DeltaGraph (< Verison 3.0) auf DeltaGraph Professional en. 4.0 DT500U 219,— ➀ ➁
DesignWorks en. 3.1.4 CC502U a.A. ➀ ➁
Digital Performer => dt. 2.0 dt. 2.0 UN515U 309,— ➀ ➁
Director Multimedia Studio en. 6.0 MM535U 1.168,— ➀ ➁
Director Multimedia Studio en. 6.0 MM935U 1.348,— ➀ ➁
DiskDoubler => Pro engl. 1.1 SY707U 98,— ➄
Dos Mounter 95 dt. SA543U 92,— ➄
Dramatica Pro en. 2.0 SY641U 278,— ➀ ➁
Excel dt. 5.0 1MLP MS520V 328,—
Excel dt. 5.0 MS520U 379,—
Excel en. 5.0 MS522U 269,—
eXodus (von Version 5.2) en. 6.1 WS598V 288,— ➀ ➁
eXodus für Windows (von Version < 5.2) en. 6.1 WS998U 288,— ➀ ➁
Expressionist en. 3.18 PH602U 228,— ➀ ➁
FastPlot Pro 1er-Lizenz dt.                                                                                                                   MT502U                  a.A.                   ➀        ➁                                                    
➀ Name und Anschrift des reg. Benutzers ➁ Angabe der Seriennummer ➂ Photokopie der Seriennummer
➃ Originaldiskette/CD ➄ Photokopie der Originaldiskette/CD ➅ Photokopie des Kaufbelegs ➆ Handbuchdeckel



Produktbezeichnung                                                                                                                Best.-Nr.                 VK                  Erforderlich                                                          
FastTrack Schedule en. 4.0 AM541U 239,— ➀ ➁
FaxExpress Server mit 10 Netzwerkteilnehmern dt. 4.0.4 GL561K 549,— ➀ ➁
Faxexpress Server +3user 2.x => 4.0 dt. 4.0.4 GL561G 299,— ➀ ➁
Faxexpress Server +5user => 4.0 GL561J 359,— ➀ ➁
Faxexpress Solo 2.x => 4.0 dt. 4.0.4 GL560U 85,— ➀ ➁
FAXstf Einzelplatz (von Version 2.x oder StartFaxing) dt. 3.2.2 ST581U a.A. ➀ ➁
FAXstf Einzelplatz (von Version 3.X) dt. 3.2.2 ST581V a.A. ➀ ➁
Fileguard Remote Office-Pack für 10 Benutzer dt. 3.0 AS584U 709,— ➀ ➁ ➄
Fileguard Update dt. 3.0 AS581U 149,— ➀ ➁ ➄
FileMaker Pro (von allen Versionen außer FileMaker Pro 2.0) en. 3.0 CL561U 286,— ➀ ➁
FileMaker Pro dt. 3.0.3 CL562U 286,— ➀ ➁
FileMaker Pro Server dt. 3.0 CL563U 858,— ➀ ➁
FileMaker Pro Windows dt. 3.0 CL962U 286,— ➀ ➁
Finale 3.5 => dt. 3.7.2 dt. 3.7.2 CM503V 199,— ➀ ➁
Finale => dt. 3.7.2 dt. 3.7.2 CM503U 658,— ➀ ➁
Fontographer => engl. 4.1 MM518U 279,— ➀ ➁
Fontographer Windows en. 4.1 MM918U 279,— ➀ ➁
Formatter Five en. 3.0 SA541U 128,— ➄
Fortran 77 4.x => Fortran Pro 5.0 AO304U 1.298,— ➀ ➁
Fortran77 4.2=> 4.4 AO301V 768,— ➀ ➁
FrameMaker (von Version 4.x) dt. 5.1 FR502U 649,— ➀ ➁
FrameMaker für Windows (von Version 4.x) dt. 5.1 FR902U 649,— ➀ ➁
Framemaker engl. => 5.1 FR501U 428,— ➀ ➁
FreeHand (von Version 5.x) dt. 7.0 MM507V 489,— ➀ ➁
FreeHand (von Versionen < 5.0) dt. 7.0 MM507U 699,— ➀ ➁
FreeHand 6er-Lizenz dt. 7.0 MM507J 2.259,— ➀ ➁
FreeHand en. 7.0                                                                                                                                  MM508U                  699,—              ➀        ➁                                                    
➀ Name und Anschrift des reg. Benutzers ➁ Angabe der Seriennummer ➂ Photokopie der Seriennummer
➃ Originaldiskette/CD ➄ Photokopie der Originaldiskette/CD ➅ Photokopie des Kaufbelegs ➆ Handbuchdeckel



Produktbezeichnung                                                                                                                Best.-Nr.                 VK                  Erforderlich                                                          
Freehand => 7.0 dt. 11er Lizenz MM507K 3.799,— ➀ ➁
Freehand Sidegrade dt. 5.0 MM907U 699,— ➀ ➁
GlobalFax Upgrade für PowerPort 500- und Duo-Serie en. 2.5 GV514V 58,— ➀ ➄
Golive Pro 1.1 => Cyberstudio 1.0 en. 2.0 GO322U 45,— ➀ ➁
Hard Disk Toolkit en. 2.0.5 FW506U 118,— ➀ ➁
Hard Disk Toolkit Personal Edition en. 2.0 FW508U 69,— ➀ ➁
HotMetal Pro => 3.0 en. 3.0 SQ511U 109,— ➀ ➁
Igor Pro (von Version 2.0) en. 3.0 WM582K 188,— ➀ ➁
Igor Pro 2.x => 3.0 WM582V 298,— ➀ ➁
Igor Pro x.x => 3.0 WM582U 608,— ➀ ➁
Illustrator (von jeder Version) dt. 7.0 AD598U 399,— ➀ ➁
Infini-D dt. 3.5 SC522U 278,— ➀ ➁
Infini-D en. 4.0 SC521U 678,— ➀ ➁
Inspiration en. 4.1 CE592U a.A. ➀ ➁
Kai's Power Tools dt. 3.0 HS610U 129,— ➀ ➁ ➄
KaleidaGraph en. 3.08 SY691U 118,— ➀ ➁
KPT Bryce (von allen Vorversionen) dt. 2.0 HS616U 169,— ➀ ➄
LS Fortran/68K auf PPC CD-ROM en. 3.3 LN303U a.A. ➀ ➁
Mac Justitia (neue Gebühren) OY500U a.A. ➀ ➃
MacFlow => dt. 4.0 MY518U 348,— ➄
MacFlow en. 4.0 MY509U 348,— ➄
MacFortran II (von Version 2.x oder MacFortran/020) en. 3.4 AO503U 578,— ➀ ➁
MacFortran x.x => Fortran 77 4.4 AO301U 878,— ➀ ➁
MacLink Plus/PC Connect en. 9.0 DV502U 109,— ➀ ➁ ➄
MacPlot HP-GL/2 => Raster MO514U a.A. ➀ ➁
MacPlot Professional (von Version 3.6) en. 4.2.2 MO504U 499,— ➀ ➁
MacPlot Professional en. 4.2.2                                                                                                             MO504V                  119,—              ➀        ➁                                                    
➀ Name und Anschrift des reg. Benutzers ➁ Angabe der Seriennummer ➂ Photokopie der Seriennummer
➃ Originaldiskette/CD ➄ Photokopie der Originaldiskette/CD ➅ Photokopie des Kaufbelegs ➆ Handbuchdeckel



Produktbezeichnung                                                                                                                Best.-Nr.                 VK                  Erforderlich                                                          
MacProject Pro 1.x => 1.5 CL512U 179,— ➀ ➁
MacWrite Pro dt. 1.5 (von MacWrite II/MacWrite Pro 1.0) CL556U 179,— ➀ ➁
Macromedia Director dt. 6.0 MM542U 898,— ➀ ➁
Macromedia Director en. 6.0 MM541U 898,— ➀ ➁
Macromedia Director Windows dt. 6.0 MM942U 898,— ➀ ➁
MarcoPolo (von Version 1.x) en. 3.0 MY534U 428,— ➄
MarcoPolo => dt. 3.0 + OCR MY543J 478,— ➀ ➃
MarcoPolo dt. 3.0 MY543U 348,— ➀ ➃
MasterJuggler Pro en. 2.0 AS512U 95,— ➀ ➁
MathType en. 3.5 DS501U 98,— ➀ ➁
MathType Equation Editor für Microsoft Word en. 3.5 DS503U 178,—
MathType Equation Editor Windows en. 3.5 DS903U 178,—
MathType Windows (von Version X.X) en. 3.5 DS901U 98,— ➀ ➁
MC minicad BASIC auf PRO Einzelplatz dt. 6.0.1 DI513U 678,— ➀ ➁ ➃ ➆
McCAD PCB-1 en. 4.0 VA500U 388,— ➀ ➁
McCAD Schematics 3.2 => 3.5 VA502U 618,— ➀ ➁
MetaDesign dt. 3.0 ME501U a.A. ➀ ➁
MiniCAD+ dt. 6.0 DI502X 1.088,— ➀ ➁ ➃ ➆
Morph en. 2.5 GY501U 98,— ➀ ➄
Multimedia Studio => dt. 6.0 dt. 6.0 MM557U 1.348,— ➀ ➁
NisusWriter WorldScript-Version dt. 5.0 NS549U 189,— ➀ ➁
Nisuswriter Worldscript => 5.0 ohne Handbuch dt. 5.0 NS549V 149,— ➀ ➁
Norton Utilities dt. 3.5 SY702U 128,— ➄
Norton Utilities en. 3.5 SY705U 148,— ➄
Now Contact & Now Up-to-Date 1er-Lizenz Update en. 3.6 NW534U 89,— ➀ ➁
Now Utilities Single User Update en. 6.7 NW528U 89,— ➀ ➁
Object LOGO Student Edition en. 2.7                                                                                                  CO509U                    18,—                                                          ➄                   
➀ Name und Anschrift des reg. Benutzers ➁ Angabe der Seriennummer ➂ Photokopie der Seriennummer
➃ Originaldiskette/CD ➄ Photokopie der Originaldiskette/CD ➅ Photokopie des Kaufbelegs ➆ Handbuchdeckel



Produktbezeichnung                                                                                                                Best.-Nr.                 VK                  Erforderlich                                                          
ObjectLogo 2.6 => 2.7 en. 2.7 CO502U 18,— ➄
Office CD-ROM dt. 4.21 MS532X 748,—
Office Diskettenversion dt. 4.21 MS532U 748,—
Office dt. 4.21 1 MLP MS532K 689,—
OmniPage (Vollversion) auf OmniPage Professional dt. 7.0 CA514U 399,— ➀ ➁
OmniPage Professional (von Version 6.0) dt. 7.0 CA512U 278,— ➀ ➁ ➅
PageMaker dt. 6.5 AD602U 449,— ➀ ➁
PageMill dt. 2.0 AD702U 138,— ➀ ➁
Painter dt. 4.0 FD503U 248,— ➀ ➁
Panorama en. 3.1 PV502U 328,— ➀ ➁
Personal MacLAN Connect für Windows 95 CD-ROM en. 6.1 MR527U 248,— ➀ ➁
Persuasion dt. 3.0 AD628U 538,— ➀ ➁
PhotoShop (von allen OEM- und Vollversionen) dt. 4.0 AD509U 589,— ➀ ➁
Photoshop Crossgrade Photoshop (von Photshop LE oder Windows-Version) dt. 4.0 AD509O 589,— ➀ ➁
Photoshop en. 4.0 AD508U 499,— ➀ ➁
Photoshop Windows dt. 4.0 AD909U 589,— ➀ ➁
Poser CD-ROM en. 2.0 FD509U 189,— ➀ ➁
PosterWorks en. 4.0 SP500U 418,— ➀ ➁ ➄
Power Machten en. 4.0.3 TI301U 199,— ➀ ➁
PowerDraw en. 6.0 CS591U a.A. ➀ ➁
PowerPoint dt. 4.0 MS571U 379,—
Powerprint => en. 3.0.2 en. 3.0.2 GD532U 48,—
Premiere (von Version 2.0) dt. 4.2 AD518U 529,— ➀ ➁
Project => dt. 4.0 MS540U 438,—
QuicKeys (von allen Vorversion) dt. 3.6 CE566U 98,— ➀ ➁
QuicKeys (von Version ≤ 2.1.x) en. 3.5 CE552U 98,— ➀ ➁
QuickMail Administrator mit 5 Benutzern (von Version 2.6) dt. 3.6                                                  CE565U                    219,—              ➀        ➁                                                    
➀ Name und Anschrift des reg. Benutzers ➁ Angabe der Seriennummer ➂ Photokopie der Seriennummer
➃ Originaldiskette/CD ➄ Photokopie der Originaldiskette/CD ➅ Photokopie des Kaufbelegs ➆ Handbuchdeckel



Produktbezeichnung                                                                                                                Best.-Nr.                 VK                  Erforderlich                                                          
QuickMail Administrator-Update (von Version 2.6 oder älter) dt. 3.6 CE561U 49,— ➀ ➁
QuickMail Administrator-Update (von Version 3.0) dt. 3.6 CE561V 35,— ➀ ➁
Quickmail 3.0 => dt. 3.6 + 10 Benutzer CE558V 269,— ➀ ➁
Quickmail =>dt. 3.6 + 10 Benutzer CE558U 379,— ➀ ➁
RagTime (von 1.x/2.x/Classic/HandiWorks) dt. 4.1 BI510G 749,— ➀ ➁
RagTime (von 3.X) dt. 4.1 BI510U 499,— ➀ ➁
RagTime (von 4.0, mit Handbuch) dt. 4.1 BI510V 99,—
RAMDoubler dt. 2.0 CN500U 79,— ➀ ➁
RayDream Designer => 4.0 RY502U 198,— ➀ ➁
Retrospect dt. 4.0 DD523U 109,— ➀ ➁ ➂
Retrospect Remote (mit 3 Lizenzen) dt. 3.0 DD534V 149,— ➀ ➁ ➂
Retrospect Remote (mit 10 Lizenzen) dt. 3.0 DD533U 169,— ➀ ➁ ➂
Retrospect Remote 10weitere Liz. 3.0 DD5221 59,— ➀ ➁ ➂
Retrospect Remote 50 weitere Benutzerlizenzen dt. 3.0 DD526U 278,— ➀ ➁ ➂
SAM (von allen Versionen) dt. 4.5 SY794U 98,— ➄
SignPost en. 3.0 TG506U a.A. ➀ ➁
SoftBTX x.x => MTB 2.0 FM519U a.A. ➀ ➁
SoftWindows 95 (Version 1.0) auf SoftWindows 95 CD-ROM dt. 4.0 IS396V 199,— ➀ ➁
SoftWindows 95 (Version 3.0) auf SoftWindows 95 CD-ROM dt. 4.0 IS396K 299,— ➀ ➁
SoftWindows CD-ROM dt. 3.0 IS398J 249,— ➀ ➁
SoundEdit 16 en. 2.0 MM574U 298,— ➀ ➁
Speed Doubler dt. 2.0 CN513U 89,— ➀ ➁
StatView (von Version 4.X engl.) dt. 4.5 BD536U 368,— ➀ ➁
StatView (von Version 4.X) en. 4.5 BD524V 168,— ➀ ➁
StatView (von Version X.X engl.) dt. 4.5 BD536Q 498,— ➀ ➁
StatView (von Version X.X) en. 4.5 BD524U 298,— ➀ ➁
Statview 4.5 => 4.5 dt.                                                                                                                          BD536J                    208,—              ➀        ➁                                                    
➀ Name und Anschrift des reg. Benutzers ➁ Angabe der Seriennummer ➂ Photokopie der Seriennummer
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Produktbezeichnung                                                                                                                Best.-Nr.                 VK                  Erforderlich                                                          
Strata Studio en. 2.0 SA325U 698,— ➀ ➁
Streamline dt. 4.0 AD595U 278,— ➀ ➁
Studio Vision Pro en. 2.0 OP515U a.A. ➀ ➁
StuffIt Deluxe en. 4.0 AN502U 89,— ➀ ➁
StyleScript en. 3.02 GD523U 68,— ➄
Suitcase dt. 3.0 SY792U 89,— ➄
Suitcase en. 3.0 SY791U 89,— ➄
SuperCard (von Version 2.X) en. 3.0 SI532V 239,— ➀ ➁
Systat en. 5.2.1 SB511U 578,— ➀ ➃
TeamAgenda 5er-Lizenz dt. 2.5 TC568U 288,— ➀ ➁
TeamAgenda dt. 2.5 TC567U 99,— ➀ ➁
TextBridge dt. 3.0 XX503U 149,— ➀ ➁
TextBridge Pro dt. 3.0 XX504U 249,—
The Norton DiskLock DiskLock en. 4.0 SY704U 89,— ➄
Theorist en. 2.02 PH601U 208,— ➀ ➁
THINK Pascal en. 4.0.1 SY703U 199,— ➄
THINK Reference en. 2.0 SY790U 99,— ➄
Timbuktu Singleuser auf Professional en. 4.0 FA504U 229,— ➀ ➁ ➄
TopDown en. 4.5 KR551U 168,— ➀ ➁
True BASIC Standard Edition Language System and Runtime Upgrade für Macintosh en. 5.0 TB531U 188,— ➀ ➁
True BASIC Standard en. 2.61 TB501U 78,— ➀ ➁
Type Manager Deluxe CD-ROM dt. 4.0 AD531X 108,— ➀ ➁
Type Reunion dt. 2.0 AD506U 68,— ➀ ➁
VersaTerm auf VersaTerm Pro en. 5.0 SY693U 298,— ➀ ➁
VersaTerm en. 5.0 SY694U 118,— ➀ ➁
VersaTerm Pro en. 5.0                                                                                                                          SY692U                    118,—              ➀        ➁                                                    
➀ Name und Anschrift des reg. Benutzers ➁ Angabe der Seriennummer ➂ Photokopie der Seriennummer
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Produktbezeichnung                                                                                                                Best.-Nr.                 VK                  Erforderlich                                                          
VIP-BASIC en. MY504U 228,— ➄
VIP-C MY507U 228,— ➄
Voyager II (von v1.2) en. 2.0 CI501U 148,— ➀ ➁
Voyager II (von v1.2, Kauf nach dem 01.02.92) en. 2.0 CI502U 208,— ➀ ➁
WebSTAR inkl. Serverlizenz inkl. PageMill CD-ROM en. 2.0 SN584U 419,— ➀ ➁
Word dt. 6.0.1 MS557U 379,—
Word en. 6.0.1 MS556U 269,—
Works dt. 4.0                                                                                                                                        MS550U                     99,—                                                                                
➀ Name und Anschrift des reg. Benutzers ➁ Angabe der Seriennummer ➂ Photokopie der Seriennummer
➃ Originaldiskette/CD ➄ Photokopie der Originaldiskette/CD ➅ Photokopie des Kaufbelegs ➆ Handbuchdeckel
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Mac™ OS Up-To-Date

Programm für Europa

Geben Sie Ihrem neuen Mac OS Computer 
die aktuelle Version des Mac OS !

Das Mac OS Up-To-Date-Programm hat Apple zusammen mit an diesem
Programm teilnehmenden Herstellern, die Lizenznehmer von Mac OS sind,
initiiert. Bei qualifizierten, neuen Mac OS Computern ist die aktuelle Version
des Mac OS im Preis enthalten, auch wenn diese beim Kauf noch nicht installiert
ist. Die aktuelle Version des Mac OS kann für solche Mac OS Computer ohne
weitere Kosten per Post bestellt werden. Füllen Sie einfach das beiliegende
Bestellformular aus und senden Sie es mit einer Kopie Ihres Kaufbelegs ein. Auf
dem Kaufbeleg müssen das Kaufdatum und die erworbenen Produkte
aufgeführt sein. Bitte beachten Sie die nachfolgenden Vertragsbestimmungen.
Ihre Bestellung muß innerhalb von 180 Tagen nach dem Kauf erfolgen, also
bestellen Sie Ihre Aktualisierung am besten noch heute!

Apple Computer B.V., Apeldoorn
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VERTRAGSBESTIMMUNGEN

❍ Die aktuelle Version des Mac OS 8 ist bei den Computern im Preis enthalten, die ab 1. Juli 1997 an den Endkunden ausgeliefert wurden
und im Sinne der nachfolgenden Bestimmungen „qualifiziert“ sind. Für andere Mac OS Versionen, einschließlich der Mac OS
Aktualisierungen, die ggf. auf dem Apple WWW-Server zur Verfügung gestellt werden, gilt dieses Programm nicht. Künftige Mac OS
Versionen werden möglicherweise ebenfalls über dieses Programm zur Verfügung gestellt. Apple behält sich jedoch das Recht vor, dieses
Programm – einschließlich der Vertragsbestimmungen – jederzeit mit Wirkung für die Zukunft zu ändern oder einzustellen.

❍ Füllen Sie das Bestellformular vollständig aus und legen Sie eine Kopie des datierten Kaufbelegs bei, aus dem die Modellnummer(n) und
Seriennummer(n) der erworbenen Computer hervorgehen. Das vollständig ausgefüllte Formular und der Kaufbeleg müssen innerhalb von
180 Tagen, gerechnet ab dem Kaufdatum, bei der unten genannten Adresse eingehen.

❍ Je nach Verfügbarkeit der lokalisierten Versionen wird Ihnen die Aktualisierung innerhalb von sechs bis zwölf Wochen in Form eines
Aktualisierungspakets mit einer CD-ROM zugestellt.

❍ Die Auslieferung erfolgt durch Übergabe an die Post oder ein anderes Versandunternehmen. 

❍ Bewahren Sie eine Kopie der Vertragsbestimmungen sowie eine Kopie des ausgefüllten Bestellformulars für Ihre Unterlagen auf.

❍ Dieses Angebot gilt nicht in Kombination mit anderen Mac OS Angeboten, auch nicht mit vorherigen Mac OS Up-To-Date Programmen.

❍ Dieses Angebot beschränkt sich auf ein CD-Aktualisierungspaket pro qualifiziertem Computer.

❍ Sollte eine Bestellung für einen nicht qualifizierten Computer aufgegeben werden, wird diese zurückgesandt.

❍ Für die Nutzung des Mac OS 8 Update im übrigen gelten die Bestimmungen des Software-Lizenzvertrages, welcher dem Mac OS 8 Update-
Programm beigelegt ist.

❍ Diese Vertragsbestimmungen unterliegen dem Recht der Niederlande.
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QUALIFIZIERTE COMPUTER

Qualifiziert im Sinne dieses Programms sind Mac OS kompatible Computer, sofern:

a.) der Computer gelistet ist in der Aufstellung der „Qualifizierten Computer“; die Aufstellung ist veröffentlicht in der „Mac OS Up-To-
Date“-Internet-Seite unter http://www.euro.apple.com/macos/ 
und sofern
b.) der Computer von der Apple Computer B.V. oder einem mit der Apple Computer B.V. verbundenen Unternehmen in Europa, Afrika
oder in den Ländern des Nahen Ostens in den Verkehr gebracht wurde
und sofern
c.) (aa) entweder auf dem Computer zum Zeitpunkt des Erwerbs die aktuelle Version des Mac OS 8 nicht installiert war oder 

(bb) eine neue Version vom Mac OS 8 von Apple im Land, in dem der Computer erworben wurde, innerhalb von 30 Tagen 
nach Erwerb in den Verkehr gebracht wurde.

Anhand des Kaufbelegs (Kaufdatum und Seriennummer) Ihres Computers wird festgestellt, ob Ihr Computer qualifiziert im Sinne der
vorstehenden Bestimmung ist.

RECHNUNG ÜBER MEHRERE QUALIFIZIERTE COMPUTER

Beim Erwerb mehrerer qualifizierter Computer im Sinne dieses Programms, für die nur eine Rechnung ausgestellt wurde, haben
Sie folgende Alternative:

(1) Sie können für jeden qualifizierten Computer ein Einzelplatz-Aktualisierungspaket bestellen.

Oder 

(2) Sie können eine geringere Zahl an Einzelplatz-Aktualisierungspaketen bestellen und für die verbleibenden qualifizierten Computer ein
Vervielfältigungsrecht erwerben. (Wenn z. B. elf qualifizierte Computer auf einer Rechnung aufgeführt sind, können Sie zwei Einzelplatz-
Aktualisierungspakete und für die neun verbleibenden Computer ein Vervielfältigungsrecht erwerben.)

Das Vervielfältigungsrecht löst keine weitere Lizenzgebühr aus. Das Aktualisierungspaket selbst ist im Preis des qualifizierten Computers
enthalten. Pro Kaufbeleg ist ein eigenes Bestellformular erforderlich.
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Mac™ OS Up-To-Date Bestellformular
Bitte bestellen Sie Ihre Mac OS Aktualisierung wie folgt:

1. Lesen Sie die Abschnitte „Vertragsbestimmungen“ und „Qualifizierte Computer“, um sicher zu sein, daß Sie das Programm in Anspruch nehmen können.

2. Fügen Sie eine Kopie des datierten Kaufbelegs bei, aus dem die Modellnummer(n) und Seriennummer(n) der qualifizierten Computer
hervorgehen, für die Sie ein Aktualisierungspaket bestellen möchten. Für jeden Kaufbeleg ist ein eigenes Bestellformular erforderlich.

3. Geben Sie Name und Adresse des Käufers sowie die Lieferadresse an, falls diese von der des Käufers abweicht:

4. 
Geben Sie die Modellnummer, Produktbezeichnung und Anzahl der im Sinne dieses Programms qualifizierten Computer an:

Modellnr.: Produktbezeichnung (inkl. Hersteller): Seriennr.: Menge:

z.B. M5516B/A Apple 5400/160/16/1.6/8xCD/28.8 CK12345678A 1

------------------------- --------------------------------------------------------------------------------------------- ------------------------------------------- ---------------

------------------------- --------------------------------------------------------------------------------------------- ------------------------------------------- ---------------

Käufer (BITTE IN DRUCKSCHRIFT)

Anrede: LL Herr LL Frau

Name: LLLLLLLLLLLLLLLLLLLLLLLL
Organisation: LLLLLLLLLLLLLLLLLLLLLLLL
Anschrift: LLLLLLLLLLLLLLLLLLLLLLLL

LLLLLLLLLLLLLLLLLLLLLLLL
LLLLLLLLLLLLLLLLLLLLLLLL

PLZ: LLLLLLLL Ort:LLLLLLLLLLLLLL
Land: LLLLLLLLLLLLLLLLLLLLLLLL
Telefon: LLLLLLLLLLLLLLLLLLLLLLLL
Lieferadresse – falls nicht mit der des Käufers identisch (BITTE IN DRUCKSCHRIFT)

Anrede: LL Herr LL Frau

Name: LLLLLLLLLLLLLLLLLLLLLLLL
Organisation: LLLLLLLLLLLLLLLLLLLLLLLL
Anschrift: LLLLLLLLLLLLLLLLLLLLLLLL

LLLLLLLLLLLLLLLLLLLLLLLL
LLLLLLLLLLLLLLLLLLLLLLLL

PLZ: LLLLLLLL Ort:LLLLLLLLLLLLLL
Land: LLLLLLLLLLLLLLLLLLLLLLLL
Telefon: LLLLLLLLLLLLLLLLLLLLLLLL



BITTE HIER
 ABTRENNEN

Hinweis: Modellnummer und Produktbezeichnung befinden sich auf dem weißen Etikett auf dem Verpackungskarton des Computers. Sie
können diese auch in der vom Hersteller mitgelieferten Dokumentation finden. Die Seriennummer befindet sich auf einem kleinen Etikett
an der Rückseite des Computers. Sie ist häufig neben einem Strichcode aufgedruckt. Falls der in diesem Formular vorgegebene Platz nicht
für alle Modelle ausreicht, fügen Sie bitte ein separates Blatt mit den erforderlichen Informationen für alle weiteren Geräte bei. Es ist nicht
erforderlich, Informationen über Monitor, Tastatur oder andere an Ihren Computer angeschlossene Apple Periphereriegeräte aufzuführen.

5. Geben Sie an, wie viele Aktualisierungspakete Sie benötigen. Wenn auf einer Rechnung mehrere im Sinne dieses Programms qualifizierte
Computer aufgeführt sind, können Sie ein oder mehrere Aktualisierungspakete und für verbleibende Computer ein Vervielfältigungsrecht
erwerben. Ausführliche Informationen hierzu finden Sie oben im Abschnitt „Rechnung über mehrere qualifizierte Computer“.

Mac OS CD-Aktualisierungspaket,  Einzelplatzversion

Anzahl der erforderlichen Pakete: LLLL
Gewünschte Mac OS Sprachversion der Pakete:

Deutsch für Deutschland/Österreich (D) ❑ Deutsch für die Schweiz (SD) ❑ Intern. englische Version (Z) ❑
Hinweis: Alle im Sinne des Programms qualifizierten Computer müssen auf einem Kaufbeleg aufgeführt sein.

Anzahl der Lizenzen für verbleibende Computer, für die ein Vervielfältigungsrecht beantragt wird: LLLL
Hinweis: Die Gesamtanzahl von Aktualisierungspaketen und Vervielfältigungsrechten darf die Anzahl der auf dem Kaufbeleg
ausgewiesenen qualifizierten Computer übersteigen.

6. Datieren und unterschreiben Sie dieses Formular: 

Ich versichere, daß ich (oder meine Organisation) zur Teilnahme am „Mac OS Up-To-Date“-Programm berechtigt bin (ist) und daß ich die
über dieses Programm bezogenen Kopien des Mac OS ausschließlich auf den hier genannten im Sinne dieses Programms qualifizierten
Computern installieren werde.

Mit dieser Bestellung erkläre ich mein (unser) Einverständnis zu den oben genannten Vertragsbestimmungen sowie zu den
Abwicklungsmodalitäten dieses Programms. 

Unterschrift: __________________________________________ Datum: __________________

Apple und Partner von Apple würden Ihnen gerne aktuelle Produktinformationen und Angebote zusenden. Bitte unterschreiben Sie hier
noch einmal, wenn Sie damit einverstanden sind, daß Ihre persönlichen Daten für diesen Zweck genutzt werden.

Unterschrift: __________________________________________ Datum: __________________

7. Bitte senden Sie diese Bestellung zusammen mit dem erforderlichen Kaufbeleg an:

Mac OS 8 Up-To-Date,  Apple Computer Fulfi l lment,  PO Box 50, Cork, Irland

Bitte beachten: Abhängig von der Zeit, die für die Lokalisierung des Mac OS erforderlich ist, kann sich die Auslieferung für einige
Sprachversionen leicht verzögern. Bitte rufen Sie das Apple Assistance Center Ihres Landes an, wenn Sie weitere Informationen hierzu
benötigen. Die Telefonnummer des Apple Assistance Center Ihres Landes finden Sie in den entsprechenden Unterlagen.

Mit freundlichen Grüßen,

Apple Computer B.V.
Laan van Westenenk 492
NL-7334 DS Apeldoorn
Niederlande
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This Read Me file contains last-minute product information for the Adobe Acrobat 
Reader 3.0 for Macintosh.

For full instructions on using the Acrobat Reader please see the Acrobat Reader 3.0 
Online Guide, which can be found in the file READER.PDF in the Help folder (which 
is in the same folder as the Acrobat Reader).  When using  Acrobat Reader, selecting 
the Help > Reader Online Guide menu will open READER.PDF automatically. (Note: 
the Help menu is the second menu from the right and is indicated by a Question 
mark icon.)

Adobe encourages you to register as an Acrobat Reader user; letting us know who 
you are helps us continue to provide you with better products, better service, and the 
most up-to-date information on Adobe Acrobat. If you have not already registered, 
please do so at:

    http://www.adobe.com/acrobat/register.html

To view the latest information on Acrobat, please go to:

    http://www.adobe.com/acrobat/

================================================================
=============
Table of Contents

This document contains the following sections:

System Requirements
Improving Performance
Known Problems and Issues
  -  Installation Issues
  -  Web Browser Issues
  -  General Issues
  -  PostScript Printing Issues
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System Requirements

-  Macintosh computer with 68020 (Macintosh II series) or greater processor 
(including all Power Macintosh computers). 
-  MacOS 7.0 or later



-  3300 KB application RAM for 680x0-based Macintosh or Power Macintosh with 
Virtual Memory turned on; 5227 KB for Power Macintosh with Virtual Memory turned 
off
-  8 MB hard disk space, plus 4.4 MB additional temporary disk space  available 
during installation 
-  For viewing PDF files inside a Web browser, Netscape Navigator 3.0 or later (3.0.1 
or later recommended)
(Netscape Navigator 2.0.2 can also be used with limitations; e.g., it will not allow you 
to submit a PDF form, and operations such as printing PDF files from within 
Netscape Navigator 2.0.2 can crash your Mac.)
You may also be able to use other Web browsers that fully support the Netscape 
APIs.

================================================================
=============
Improving Performance

In most cases you can improve the performance of the Acrobat Reader and Search 
programs by increasing the memory allocated to the Acrobat Reader application and/
or to Adobe Type Manager. 

For Acrobat Reader 3.0:  
1. If the Acrobat Reader 3.0 program is running, you must first Quit. 
2. From the Finder, select the Acrobat Reader 3.0 program icon. (You must select 
the actual program, not an alias.)
3. Choose Get Info from the Finder's File menu.
4. Increase the Preferred memory allocated to the Acrobat Reader 3.0 program. 
The number you enter is based on the available free memory on your system. If you 
have enough memory, 4500 K (6427 K for PowerMac with Virtual Memory turned off) 
is recommended. Do not change the Minimum size setting.

For Adobe Type Manager:
1. Open the ~ATM™ Control Panel in the Control Panels folder within the System 
folder or in the Adobe Acrobat 3.0 / Fonts folder if you are using a private version of 
ATM.
2. Increase the font cache to 512K or greater.

================================================================
=============
Known Problems and Issues

Note: If additional problems and issues are discovered they may be posted on 
Adobe's Web site at:

    http://www.adobe.com/acrobat/

Installation Issues
===============



Viewing PDF Files Within a Web Browser - In order to view PDF files within the 
window of a Web browser (such as Netscape Navigator 3.0), the plug-in 
"PDFViewer" must be placed in the browser's "Plug-ins" folder.  If Netscape 
Navigator 2.0 or later is installed on the disk on which you're installing Acrobat 
Reader, the installer will place a copy of the "PDFViewer" plug-in in the "Plug-ins" 
folder of the first copy of Netscape Navigator it  finds.  If Adobe PageMill™ 2.0 or 
later is installed on that disk, the installer will place a copy of the "PDFViewer" plug-
in in the "Plug-ins:Browser Plug-ins" folder of PageMill.  The installer will also place a 
copy of "PDFViewer" in the "Adobe Acrobat 3.0:Web browser plug-in" folder.  

If you would like to use the Acrobat Reader with an additional copy of PageMill or 
Netscape Navigator or another Netscape compatible browser, copy "PDFViewer" to 
its plug-ins folder.  If you have multiple versions of Netscape Navigator, be sure that 
the "Plug-ins" folder associated with the version of Netscape you'll be using contains 
"PDFViewer Plug-in" version 1.0. (You can see the version using the Finder's "Get 
Info" command.)

Weblinks Outside of a Web Browser - To access URLs embedded in PDF files 
when using the Acrobat Reader outside of a Web browser, you must specify your 
preferred Web browser in Acrobat Reader's Weblink Preferences dialog.  Choose 
File > Preferences > Weblink.

Disk Space Requirements - The installation program calculates disk space 
requirements assuming that none of the software components to be installed are 
already on your system.  If you already have versions of some or all of the 
components then the disk space requirements reported by the installation program 
will be higher than the actual amount used. [118263]

PowerMac vs. 680x0 Compatibility - When an installation is performed on a 
PowerMac, the installation program automatically installs a PowerMac-only version 
of the Acrobat Reader; when an installation is performed on a 680x0-based Mac then 
a 68000 version of the Reader is installed.  It is not possible to install a "fat binary" 
version of Acrobat Reader.  This may be an issue if you are installing the Acrobat 
Reader on a hard disk which will be used from both kinds of Macintosh.

Startup Disk  - Any files installed into the System Folder by the installer will be 
installed in the active System Folder (the System Folder on the disk used to start the 
Macintosh), regardless of which disk the Acrobat Reader is being installed onto. 

How Does The Installer Handle Adobe Type Manager (ATM) and Fonts? - If ATM 
is already installed on your computer, the Acrobat 3.0 installer will update it with ATM 
4.0.

If you do not have a version of ATM installed on your computer and you do not have 
QuickDraw GX enabled, the Acrobat 3.0 installer places a copy of ATM 4.0 in the 
Adobe Acrobat 3.0 / Fonts folder. This private copy of ATM is recognized and used 
only by Acrobat Reader 3.0 and uses memory only when Acrobat Reader is running.

Based on whether QuickDraw GX is enabled or not at the time of installation, 
different versions of the Adobe Acrobat substitution fonts Adobe Sans MM and 



Adobe Serif MM (and perhaps other Type 1 fonts) are installed. Later, if QuickDraw 
GX is either enabled or disabled, you will need to re-install Acrobat Reader 3.0.

If you install System 7.5 and QuickDraw GX after installing Acrobat 3.0, you will need 
to re-install Acrobat Reader 3.0. The QuickDraw GX 1.0 installer replaces ATM 4.0 
with ATM GX (ATM 3.7), which is not compatible with Acrobat Reader 3.0.

If TrueType versions of Symbol or Zapf Dingbats are installed on your system they 
are not replaced nor moved. If you are using Type 1 versions of these fonts, updated 
versions of the Type 1 fonts Symbol and Zapf Dingbats will be installed in the 
appropriate location for your version of System 7.

Acrobat Reader Memory Requirements - Memory requirements settings for 
Acrobat Reader 3.0 can be set by selecting the Acrobat Reader 3.0 icon in the 
Finder and choosing Get Info from the File menu. In the Memory Requirements 
section of the dialog, the "factory" default for Minimum size is set to 3300 K (5227 K 
for PowerMac with Virtual Memory turned off) and should not be changed. The 
Preferred memory size is 4500 K  (6427 K for PowerMac with Virtual Memory turned 
off) and may be adjusted as described below.

If you are using ATM in the Adobe Acrobat 3.0 / Fonts folder, it allocates 
approximately 1000 K of RAM (800K of RAM for 680x0 processors) out of the 
Acrobat Reader 3.0 partition. On a Macintosh with a 680x0 processor, if there is not 
sufficient space or if Virtual Memory is on, ATM attempts to allocate RAM from 
System memory.

If you are using system-level ATM on a 680x0-based (non-PowerMac) system you 
can reduce the Preferred size value for Acrobat Reader 3.0 by 800K.

If you are using Acrobat Search, you should be aware that each active index in the 
Index Selection dialog uses approximately 50K of memory from the application's 
memory partition. If you add more than three indexes to this list, you may want to 
consider increasing the Preferred size by 50K for each additional index.

If you are not using Acrobat Search you can reduce the Preferred size value for 
Acrobat Reader 3.0 by an additional 510K (360K for Search and 150K for three 
indexes).

Plug-in Names - Removing plug-ins from the Reader's Plug-Ins folder can improve 
performance and reduce the  memory required to use the Reader.  When removing 
plug-ins, refer to the following list of the Reader plug-ins' file names and their 
functionality:

Acrobat Search        Search  (installed only with Acrobat Reader + Search 
installer)

Acrobat Weblink     Weblink
AcroForm                  Forms
EWH                          External Window Handler   (communicates with Web 

browser)
HLS                            Highlight server  (highlights results of Web-based search)



Movie                         Movie and Sound
OLE                           OLE Server  (installed by optional OLE installer)

Web Browser Issues
=================

PDFViewer Browser Plug-in -  Acrobat Reader 3.0 and Netscape Navigator 
communicate with each other via two plug-ins installed with Adobe Acrobat 3.0; one 
called "EWH" on the Acrobat side in the "Adobe Acrobat 3.0:Plug-Ins" folder and one 
called "PDFViewer" in Netscape Navigator's "Plug-ins" folder.  A copy of the 
"PDFViewer" plug-in is also installed in the "Adobe Acrobat 3.0:Web Browser Plug-
in" folder.

If you have multiple versions of Netscape Navigator, be sure that the "Plug-ins" 
folder associated with the version of Netscape you'll be using contains "PDFViewer".

Make sure both plug-ins are from the same Acrobat release. Opening an Acrobat 
document from within a copy of Netscape Navigator which uses an old version of the 
"PDFViewer" plug-in may cause your browser to crash.   [148104]

Using the PDFViewer browser plug-in with a Web browser not fully compatible with 
Netscape Navigator's plug-in architecture may cause your browser to crash.

Microsoft Internet Explorer -  Microsoft Internet Explorer version 2.0 and later for 
Macintosh has a plug-in folder for Netscape Navigator plug-ins.  However, Internet 
Explorer versions 2.0 or 2.1 do not fully support PDFViewer (Acrobat's Netscape 
Navigator plug-in) and may crash when it is used.  Rather than using this plug-in, 
Adobe recommends that users of Internet Explorer 2.0 or 2.1 configure the Acrobat 
Reader as a helper application.   [148027]

For information about configuring helper applications in Internet Explorer see 
Help:Customize:filetype.htm in the Internet Explorer documentation or see:

    http://www.adobe.com/acrobat/moreinfo/

Microsoft Internet Information Server - The Microsoft Internet Information Server 
(IIS) version 2.0 distributed with Windows NT Server 4.0 includes built-in support for 
byteserving (byte range serving) PDF files. However, the shipping version of IIS 2.0 
has a bug which causes it not to return all the bytes needed to display some PDF 
files  (regardless of whether or not the PDF files are optimized).

Microsoft has corrected these bugs in updated versions of three Windows NT 4.0 
DLL files (httpodbc.dll, infocomm.dll, and w3svc.dll). These updated files will be 
included with Windows NT 4.0 Service Pack 2 which Microsoft expects to release in 
December 1996. Before then, Windows NT 4.0 owners can contact Microsoft's pay 
per incident product support group (in the U.S. their phone number is 800-936-5900) 
and request "NT hot fix number 56945".  If you install Windows NT 4.0 Service Pack 
1, be sure to reinstall this hot fix afterwards.



Movie / Netscape Navigator - When viewing a PDF file in the Navigator window, if 
you click on a movie annotation and there is no movie file on the web server the 
system will crash. [143803]

PDF files with movies and sounds work inside of World WideWeb browsers, but the 
performance is generally unacceptable. Acrobat's Movie plug-in is best used for disk- 
and CD-ROM-based applications. [174588]

Netscape Navigator 2.0 limitations - Adobe recommends using  Netscape 
Navigator 3.0 or later with Acrobat Reader rather than Netscape Navigator 2.x (2.0, 
2.0.1, or 2.0.2) for the following reasons:  

- Netscape Navigator 3.0 or later is required to submit and receive Acrobat Form 
Data Format (FDF) files over the Web.  

- When Acrobat Reader is used as a plug-in to Netscape Navigator 2.x, using 
Netscape Navigator's File > Print... menu to print PDF documents will cause 
Navigator to crash; you can print PDF documents using the print icon at the left end 
of the Acrobat toolbar.

- When Acrobat Reader is used as a plug-in to Netscape Navigator 2.x on a 680x0-
based Macintosh, causing Netscape Navigator to go back to a previously viewed 
page while a PDF file is being downloading may cause Navigator to crash.
 
- Navigator 2 does not support printing PDF files displayed in HTML frames.

- Navigator 2.0J and Acrobat 3.0 will crash when used on KanjiTalk systems. 
[152495]

The Acrobat Reader 3.0 installer will attempt to install "PDFViewer"  (Acrobat's 
Netscape Navigator plug-in) in the plug-in folder of Netscape Navigator 2.0 or later.  
If you must use Navigator 2.0, 2.0.1, or 2.0.2 and would prefer to use Acrobat 
Reader as a helper application, be sure to remove "PDFViewer" from Navigator's 
plug-ins folder and then configure the Acrobat Reader as a helper application.   

Netscape Navigator 

- Printing HTML pages with embedded PDF files will cause Netscape Navigator 3.0 
to crash the next time the user goes to a different page.  Netscape has fixed this bug 
in Navigator 3.0.1. [161267]

- Due to a bug in Netscape Navigator 3.0, when viewing PDF within a frame, if you 
resize the window and quit Navigator before the page is done drawing, Navigator 
and/or Acrobat will crash. [175265]

- If Netscape Navigator 3.0 is running in the background it will ignore the very first 
request from another application such as the Acrobat Reader.  Requests which might 
be ignored include clicking on a Weblink in a PDF document, choosing an Acrobat 
Reader help menu item which opens a Web page, or handling returning an FDF file 
in response to an HTML form.  If your request has been ignored make the request a 



second time.  [160925]

- Changes to Acrobat preferences while viewing PDF files within Netscape Navigator 
will not take full effect until you exit Reader and restart. [160324]

- When large PDF files which have NOT been optimized for page-at-a-time 
downloading are downloaded over very slow transmission lines (e.g. slow modems), 
the Acrobat Reader may "time-out" before the entire file has been downloaded.  
Aternatively, the first page of the document may be displayed but changing to 
another page could result in a blank page being displayed until the document is fully 
downloaded. [143637, 179356]

- When using Navigator's Back button or Go menu to return to a previously viewed 
PDF document, page 1 of that document may be displayed regardless of the page 
you were last viewing.  This will occur if the entire document was not downloaded or 
if the General Preferences "Allow Background Download of Entire File" option was 
not enabled. [122652]

- Pressing the "end" keyboard shortcut to go to the last page may cause Navigator to 
shift the Acrobat window upwards obscuring a portion of the Acrobat toolbar and 
displaying a second Acrobat status bar. Clicking Navigator's Reload button will fix 
this. [143469]

-Many of the typical Acrobat keyboard navigation accelerators (arrow keys, page up/
down, home/end) are not always available when viewing PDF files within the 
Netscape Navigator window.  [142844,146972]

- When viewing a document which is wider than the browser window and is set to 
"Hide Window Controls" a horizontal scroll bar appears across the bottom of the 
browser windows after opening the PDF and using the Hand tool to scroll left and 
right. The scrollbar is unusable and the window functions as if it didn't exist. [151952]

- If a file can be opened by Netscape Navigator you can open it by draging its icon 
into a Navigator window and dropping it onto an HTML page; however, dropping a 
file onto a PDF page displayed in Navigator will not open it.

- The filename extension ".pdf" must be at the end of the PDF file name in order to 
use the drag-and-drop method of opening a PDF file in the Netscape Navigator 
browser. [153245]

- To open a PDF file from Navigator's File > Open… command, you need to hold 
down the Option key when opening the dialog to be able to select a PDF file from the 
list; otherwise, only HTML and TEXT files are displayed in the Open dialog. [163393]

- Use the Page Setup command in Acrobat Reader to affect the printing of PDF 
documents viewed within Navigator; Navigator's Page Setup dialog has no effect 
when printing PDF files.

- Navigator mail enclosures of PDF don't open properly in Navigator. [163103]



- "Open File" links and bookmarks to non-PDF files will not work when activated 
while viewing the PDF file in the Netscape Navigator window. [147871]

- Using "marginwidth" and "marginheight" in the HTML for a frame which contains a 
PDF file results in the PDF file being positioned improperly. This is a bug in 
Navigator that Netscape plans to fix in Navigator 4.0. [162546]

Documents with pages larger than 4 MBytes each may have display problems. 
[155364]  

Weblink - When viewing a PDF file in a web browser, the destination of a Weblink is 
not displayed in the control bar even if the Weblink preference is set to do so. 
[144784] 

When opening a PDF file from the Web using Netscape Navigator, if other 
applications running on your Macintosh are using large amounts of CPU time and 
the  "Allow Background Download of Entire File" option in the Acrobat General 
Preferences dialog is enabled you may have to wait until most of the document has 
downloaded before the first page will be displayed.  [174552]

Netscape Navigator / Forms Posting and Receiving 
- Netscape Navigator 3.0 or later is required to submit and receive Acrobat form files 
(called FDF files or Forms Data Format files) over the Web.  

- To allow posting and receiving FDF forms data to/from a secure server to work 
properly, turn on the Navigator Network Preferences Option "Allow Persistent 
Caching of Pages Retrieved through SSL".

Netscape Navigator / HTML Form Returning FDF File - The very first time you use 
Netscape Navigator to submits an HTML form which returns an FDF file, Navigator 
will display a dialog which says you have started to download a file of type 
application/vnd.fdf.  Click the "Pick App..." button and select the Acrobat Reader you 
use with Netscape. [160928]

Weblink - Weblinks to an invalid URL or secure site do not pass control to 
NetscapeNavigator. [117258,117346]

- Webinks to "mailto" and "newsgroups" URLs do not work correctly. [149676, 
175397]

General Issues
=============

4-Color Mode - If the Monitor control panel is set to 4 colors, Acrobat Reader uses 
the system's highlight color in its color palette which results in poor color rendering of 
images. Work around: Increase the number of colors available to your computer by 
selecting the Monitors control panel and clicking on a larger number of colors.

Adobe Type Reunion 1.2 - Adobe Type Reunion 1.2 is not compatible with the 



Forms plug-in in Acrobat 3.0. Solution: Upgrade to Adobe Type Reunion 2.0. 
[150044]

Calibrated Color - The "Use Calibrated Color for Display" option in the General 
Preferences dialog is only functional if you have the Acrobat Device-Independent 
Color plug-in installed. [163728] 

Continuous View and Notes - Text notes which extend outside (above or below) of 
the page boundary when viewed in Single Page mode may get clipped when you 
switch to Continuous or Continuous - Facing Pages mode. Solution: Click on the 
note to activate it and it will pop to the surface. [148150]  

Desktop Printing (GX) - If QuickDraw GX is enabled, Acrobat Reader requires 
Desktop Printing to be turned on to print.

Font Not Found - A font not found error may indicate that ATM did not have enough 
memory to create a substitute font. Increase the size of the ATM font cache to solve 
the problem. See the ATM section of this file for information on how to increase the 
memory (font cache) available to ATM.

Full Screen Preferences - Changes to full-screen preferences do not take effect 
until you exit and re-enter full-screen mode. [163985]

Making PDF documents accessible from the Macintosh Finder - PDF files 
created on Windows or UNIX systems will have a PDF icon and cannot be opened 
on the Macintosh by double-clicking. To enable double- clicking to open the PDF 
files, do one of the following:

- Open the file on the Macintosh using File > Open or dragging the icon onto the 
Acrobat Reader icon. After you have opened the file on the Macintosh once, the next 
time the Finder redisplays the icon (e.g. because you have moved it or simply closed 
and opened the folder containing it ) it will display a PDF icon, enabling opening by  
double-clicking.

-  Use the PDF Type Utility to set the file type and creator on the Macintosh.
To use the utility, you simply drag PDF files created on another platform to it. The 
utility adds the appropriate information so you can open the files by double-clicking.

The PDF Type Utility (Macintosh) is available in the Utility folder on the Acrobat 
Reader 3.0 CD-ROM.  It can also be found on the Web by following the pointer on 
    http://www.adobe.com/acrobat/moreinfo/

Movie / Full Screen - When viewing a movie in full-screen mode, hitting the Esc key, 
(which normally causes the movie to stop playing) may instead take the user out of 
full-screen mode. [118431]

Movie Posters - Movie posters do not print. [164996]

OLE plug-in - If you have installed the optional OLE plug-in you can incorporate 
PDF documents in compound documents created with any Object Linking and 



Embedding (OLE) 1.0 or 2.0 container application.  An installer for the OLE plug-in 
can be found on the Acrobat Reader 3.0 CD-ROM and can redistributed for no 
charge.  

- The Acrobat Reader cannot be used to to insert or create objects with OLE 
Embedding because you cannot use Reader to save or make changes to a PDF file. 
[117835]

OLE and Links/Bookmarks/Movies - Links and bookmarks to other PDF files and 
playback of external movie and sound files will not work if the PDF file is embedded 
as an OLE object. [109027,118373]  

Page Caching - When page caching is enabled, caching is active when there is no 
mouse movement. If you have the zoom-in tool selected and press the option key to 
toggle to zoom-out, you may not see the cursor change until you move the mouse, 
which in effect interrupts page caching.

Password Field - The password field will accept 255 characters, but only the first 32 
are used. [110590]   

PowerBook External Display - Acrobat Reader may not display correctly when 
running on a PowerBook 180 with an external display, mirroring on, and in 
monochrome (1-bit) mode. Solution: Turn off mirroring. Set up the external monitor 
as monitor 2 and make the external monitor the primary monitor by dragging the 
MacOS menu bar to monitor 2 (within the Monitors control panel), then restart.

QuickDraw GX - Acrobat Reader is compatible with QuickDraw GX, but it does not 
use any specific QuickDraw GX features.

- Based on whether QuickDraw GX is enabled or not at the time of installing Acrobat 
Reader, different versions of the Adobe Acrobat substitution fonts Adobe Sans MM 
and Adobe Serif MM (and perhaps other Type 1 fonts) are installed. Later, if 
QuickDraw GX is either enabled or disabled, you will need to reinstall Acrobat 
Reader, using the Easy Install option. This will make sure the proper version of the 
fonts required by Acrobat Reader are installed in their proper locations. If you install 
System 7.5 and QuickDraw GX 1.0 after installing Acrobat Reader, you will need to 
re-install  Acrobat Reader. The QuickDraw GX 1.0 installer unfortunately replaces 
ATM 4.0 with ATM GX (ATM 3.7), which is not compatible with Acrobat Reader.

- N-up printing does not work with the QuickDraw GX PostScript printer driver. 
[144248]

QuickDraw Printing - Background printing to QuickDraw printers may be very slow. 
[176817]

Rotated/Transformed TrueType Fonts - You may encounter some problems with 
displaying or printing rotated or otherwise transformed TrueType fonts. This is a 
limitation of TrueType and QuickDraw.

Search plug-in - The Acrobat Search plug-in allows searches of text in PDF files on 



a local hard disk or CD-ROM or across a local area network.  (Searching PDF files 
stored on a Web-server requires a Web-server-based search engine.)  The Acrobat 
Reader is available with or without the Search plug-in.  Acrobat Reader with Search 
can be found on the Acrobat Reader 3.0 CD-ROM and can redistributed for no 
charge.    For known problems and issues related to the Search plug-in see the 
ReadMe-Search file installed with Acrobat Reader with Search.

Sound Actions - The playback of sound actions cannot be stopped by the user (as 
opposed to the ability to stop the playback of QuickTime movies and sounds by 
pressing the Esc key). Sound actions can only be stopped by playing another sound 
action. [152859]

TrueType - TrueType fonts cannot be reencoded. Because of this limitation, 
documents that were created using some special characters in a Type 1 font that are 
not accessible if a TrueType version of the same font with the same name is installed 
on your system. When this happens, the error message "Some text in the font and 
character 'FONTNAME ###' could not be displayed or printed correctly. The font 
could not be reencoded." is displayed. Since the Acrobat installers do not replace 
TrueType versions of Times, Helvetica, and Courier you may get this message with 
these fonts. 

TrueType in Files created on Windows - Files created on Windows and containing 
TrueType fonts may not display or print correctly.  Macintosh users may see boxes 
where characters should be.

Postscript Printing Issues
=====================

Adobe PSPrinter 8.3.1 PostScript Printer Driver - For best results, we recommend 
you use the PSPrinter 8.3.1 (or later) driver from Adobe. This driver can available on 
the Adobe Web site at "http://www.adobe.com/prodindex/printerdrivers/" and in the 
"Drivers" folder on the Acrobat Reader 3.0 CD-ROM.

Adobe Type Manager (ATM) and Background Printing - If you are using the 
private copy of ATM in the Adobe Acrobat 3.0 / Fonts folder (i.e. you do not have 
ATM installed in your System's Control Panels folder) background printing is disabled 
when the using PSPrinter or LaserWriter 8.x printer drivers. Background printing is 
still enabled when using the LaserWriter 7.x printer drivers. If you are using the 
LaserWriter 8.4.x printer driver, you must explicitly turn off background printing in 
the print dialog.

PostScript Level 2 - If you are printing to a PostScript Level 2 device using the 
Adobe PSPrinter 8.x or Apple LaserWriter 8 printer drivers, you need to update the 
Printer Info after selecting the printer from the Chooser in order for the printer driver 
to recognize the printer supports PostScript Level 2. If this is not done, Acrobat 
Reader will not send PostScript Level 2 information to the printer. When properly set 
up, there will be an icon to the left of your printer name in the Chooser. During set 
up, make sure to select the specific PostScript Printer Description (PPD) file for your 
particular printer - do not select the "Generic" PPD if at all possible.



Print Monitor Setting - PrintMonitor may run out of memory when printing PDF files 
with background printing is turned on. As a precaution against this happening, you 
may want to change PrintMonitor's current memory size. To do this, open the 
Extensions folder within the System Folder. Select the PrintMonitor application and 
select Get Info from the File menu. At the bottom of the Get Info window, there is a 
field under Memory for Current Size. Increase this value to 170K or greater; if 
necessary, try increasing it to 256K.

Memory Issues - If you encounter problems, such as a "VMerror," printing to 
PostScript Level 1 or 2 printers, it may be because the printer has little available 
memory (for example, a non-upgraded LaserWriter, LaserWriter Plus, LaserWriter II 
NT or NTX). There are two potential solutions to this problem: 
(1) In the Preferences dialog (select from the Edit menu) you may choose to use  
Serif only or Sans only for font substitution. This frees up additional memory in the 
printer and chances are your document will print successfully. 
(2) The other option is to purchase more memory for your printer. See the ATM 
READ ME for additional information about printing.

Apple Personal LaserWriter NT - If you are using an Apple Personal LaserWriter 
NT printer that has not been upgraded to a Personal LaserWriter NTR, Acrobat 
Reader won't be able to print substitute fonts. Contact your Apple dealer for 
information on upgrading your printer.

QuickDraw GX - If QuickDraw GX is enabled, Acrobat Reader requires Desktop 
Printing to be turned on to print.
================================================================
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